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This is the User's Guide for Notes Menu Launcher and its main purpose 
is to unveil the possibilities in Notes Menu Launcher and to enable you to 
make the most out of the product.  

 

 

In addition software contain a small tool with the name NotesPeek Buddy 
(on page 43) to enable you to launch NotesPeek on the currently selected 
document.  

Finally, you will find a Samples-folder containing several configuration 
examples to get you going! 
 

Welcome to Notes Menu Launcher 
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What is Notes Menu Launcher ? 
The brief description; A tool to make your own applications, formulas or 
agents show up in the context menus or Action menu of Lotus Notes.  

Here is the longer description; If application developers wants to 
integrate their own applications into the Lotus Notes menus, their options 
has been very limited. Application developers won't see support for their 
own context menus until the next major release of Lotus Notes, ND 7. 

Traditionally the developer can make a so-called Notes Addin Menu, 
which in essence is a Dynamic Link Library inserting one or more menu 
lines into the Action menu in Notes. The menu addin is specified by 
adding the path and DLL name in the AddinMenus-keyword in the main 
configuration file for Notes; Notes.ini. 

When installed, a Notes Addin Menu application is sensitive to the user 
operating context, meaning that the addin "knows" when the user is 
working in a view, a document, and whether the document is in read- or 
write mode. The addin also knows which field- and field type the user are 
working in. 

Below you see a sample of some Notes Addin Menus, being present in 
the Actions menu: 

 

The menus in the red box in the figure above is Notes Addin Menus. Also 
note that one of the menu items is grayed out, indicating that the menu 
isn't available in the current context. 
 

Figure 1: Notes Action 
menu, with several menu 
addins 
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What about context menus ? 
A context menu is a menu that is sensitive to the user operation context, 
and which often is activated by clicking on the right mouse button. 
Context menus are therefore often called right click menus.  

Many users regard context menus as a more speedy way to access 
relevant features to the current operating context. 

If the developer want to integrate their solutions into the context menus 
of Lotus Notes, there hasn't been any known solution to that - until now! 

Notes Menu Launcher will let you do just that; insert your own solutions 
into the Action menu and/or the context menus in Lotus Notes! Below 
you see a sample on a view-based context menu: 

 

In the figure above you see several new menus at the bottom! As you also 
can see, Notes Menu Launcher even supports cascaded menus! 

 
 

And What is NotesPeek Buddy ? 
In order to show you the immediate power of Notes Menu Launcher, a 
small handy tool for the poweruser in Notes is bundled with this 
software; NotesPeek Buddy. This is a small tool that will launch 
NotesPeek on the currently selected document, and you no longer has to 
navigate through the tree-structure in NotesPeek! 

Read more about NotesPeek Buddy here. (see "NotesPeek Buddy" on 
page 43) 
 

Figure 2: Notes Context 
Menu - Example 1 
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What benefits do you get by 
registering ? 

If you configure more than two menus in the XML Configuration file 
(see "The XML File" on page 47), you will see this dialog box when 
Lotus Notes start up; 

 

If you register, you won't see this message again! 

In addition, you can configure and setup as many menus as you like!!!  

Finally, you will of course get prioritized support if you have any 
questions regarding Notes Menu Launcher or any other Voith's CODE-
product. 
 

Typographical Conventions 
Before you start using this guide, it is important to understand the terms 
and typographical conventions used in the documentation. 

For more information on specialized terms used in the documentation, see 
the Glossary at the end of this document. 

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information 
Triangular Bullet( ) Step-by-step procedures. You can follow these 

instructions to complete a specific task. 

Figure 3: Information 
About Trial Version 
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Special Bold Items you must select, such as menu options, 
command buttons, or items in a list. 

Emphasis Use to emphasize the importance of a point or for 
variable expressions such as parameters. 

CAPITALS Names of keys on the keyboard. for example, 
SHIFT, CTRL, or ALT. 

KEY+KEY Key combinations for which the user must press and 
hold down one key and then press another, for 
example, CTRL+P, or ALT+F4. 
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This chapter describes how to install Notes Menu Launcher. You will be 
guided through the automatic installer application, in addition to getting 
the nitty-gritty details of which files go where. This will help you install 
Notes Menu Launcher on multiple Notes Menu Launcher installations on 
one machine. 

In This Chapter 
Requirements .....................................................................7 
Two install methods, the installer - or - manual.................9 
The Installer .......................................................................11 
Manual Installation.............................................................25 
Security ..............................................................................35 
 
 

Requirements 
Notes Menu Launcher is a Lotus Notes based tool. This implies that 
Notes Menu Launcher won't run as a standalone windows application, but 
rather as a plugin to Lotus Notes. 

When installed, Notes Menu Launcher will reveal itself via the context 
menus and  the Actions-menu in the Lotus Notes client, and it will act on 
the selected documents in both view- and document context.  

Notes Menu Launcher has these requirements: 

 Lotus Notes Release 5.0.3 or newer 
 A Notes configuration file (Notes.ini) must be available in the 

first 128 bytes of the system PATH environment variable 
 Machine and platform requirements; The same as for the Lotus Notes 

Release 5 client, which is: 
 Windows 95, 98 or ME - Windows NT 4.x SP3, Windows 2000 

or Windows XP 

 Pentium processor 

 RAM: On Windows 9x and Windows NT more than 32 MB. On 
Windows 2000 more than 64 MB and on Windows XP more than 
128 MB. 

Diskspace: Notes Menu Launcher occupies approximately 5.5 MB.  
 

C H A P T E R  2  

Installation 
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Two install methods, the installer - 
or - manual 

Use the installer to install Notes Menu Launcher quickly on a standard 
Lotus Notes installation, or use the manual procedure to install Notes 
Menu Launcher in a more customized environment 
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The Installer 
The Installer is a setup application containing all the necessary files to 
install Notes Menu Launcher successfully. In addition it will do the 
necessary modifications to your operating system environment in order to 
let Notes Menu Launcher run flawlessly. 

Note: You operating system must meet the requirements in order to run 
Notes Menu Launcher. The Installer might report problems such as the 
example below: 

 
Here the current user doesn't have proper administration rights! 
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The initial screen 
A step-by-step guide through the standard installer. Why use the installer 
? The main benefit by using the installer, is that it does the lot for you. It 
analyses the Lotus Notes installation to figure out where you have the 
Notes program- and data directories, it places all the files and 
components of Notes Menu Launcher in the correct directories, register 
common components and finally update your Registry database with the 
correct settings. Using the installer, should be easy and straight forward. 
In addition, by using the installer, you will also get an uninstaller, so you 
can get rid of Notes Menu Launcher.  

When you first start the installer, you'll see this screen: 

 

Note that you will see the current version  of Notes Menu Launcher you 
are about to install. 
 

Figure 4: The initial 
screen in the installer 
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If Lotus Notes is still running 
If the Installer detect that Lotus Notes is still running at this stage, you 
will see this dialog box; 

 

You should either switch to Lotus Notes yourself and terminate any 
current work in Lotus Notes, or, you can push the Stop Notes button to let 
the Installer gently ask Lotus Notes to quit. Note that Lotus Notes may 
not quit automatically if you have unsaved work, so you still have to 
check that Lotus Notes actually did stop. 

Warning: If you continue without stopping Lotus Notes, you won't see the 
installed menus before you restart Lotus Notes. In addition, if you have 
already installed Notes Menu Launcher, and re-install it, several files may 
be locked by Lotus Notes and Notes Menu Launcher. You might 
therefore see dialog boxes informing you about locked or held files. 
 

Figure 5: <LN> is still 
running - warning from 
the Installer 
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Information about BETA release 
Software is developed in stages, and Notes Menu Launcher is no 
exception. When software is first released, or when new updates are 
coming, software developers often want to test new or changed 
functionality. One way to do that is to release BETA releases of the 
software. The advantage for end-users are the ability to see and use the 
software before general release. The disadvantage is often that the 
software isn't actually finished, and might not contain all the promised 
features, or it might even contain bugs at this stage! Below you see the 
dialog box for Beta information; 
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License Agreement 
As most software, Notes Menu Launcher also contains a legal license you 
must agree to in order to use the software. Read the licence and either 
agree to it - or not. If you don't agree to the licence, the installation will 
abort. You will also have the possibility to read the licence when the 
installation has finished, since it is installed together with the other files. 

 

Note: The license contain important information about how the software 
communicate over the internet! 
 

Figure 6: The License 
Agreement 
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Select target Notes clients 
Many users have multiple versions of Lotus Notes installed on one 
machine. Previous versions of Voith's CODE-software installers only 
supported the most current Lotus Notes-installation, meaning that the 
software only would install on your last installed Notes client.  

Now the Installer will analyze the Registry entries inserted by the 
different versions of the Lotus Notes-installation program, and the dialog 
box below will report- and let you select which versions of Lotus Notes 
you want to install Notes Menu Launcher on. 

 

Below is the same dialog box, with multiple Notes clients detected: 
Figure 7: Select target 
Notes clients 
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Note: If not all your Lotus Notes-client versions show up here, and you 
want Notes Menu Launcher in one or more of those versions, you must 
unfortunately resolve to the manual installation procedures later in this 
chapter. 
 

Figure 8: Multiple Notes 
clients found 
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Problem locating INI files 
This dialog box will only show if the Installer can't locate all the 
Notes.ini files for the selected Notes clients. 

 

If you scroll down, you will se exactly which Notes.ini files  the Installer 
couldn't locate. 

Note: Notes Menu Launcher will not be installed in the Lotus Notes-
clients reported in this dialog! 
 

Figure 9: Problem 
locating INI file 
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Select Installation folder 

 

The Notes Menu Launcher-installer suggest a traditional directory located 
in the Program Files directory on your computer. Change this to your 
own personal standard if you like - such as omitting the company name if 
you want a directory sorted on the program name. 

You can press the Change button to change the directory. 

Also note the size of the installation, and how much available space you 
have on your selected harddisk.  
 

Figure 10: Select 
Installation Folder 
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Ready to Install 
You are now ready to install Notes Menu Launcher. Below you see the 
last confirmation dialog box before the Installer copy the necessary files 
and modify the selected Notes.ini files. 

 

Note: The Installer will also install an Uninstaller, which will remove all 
the involved files, and restore your Notes.ini files back to normal. 
 

Figure 11: Ready to 
Install 
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Installation Progress 

The Installer will then install the necessary files and do the Notes.ini 
modifications 

 
 

Installation Finished 
If the installation goes without problems, you will see this success dialog 
box! 

 

Figure 12: Install 
Progress 
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Thank you for installing Notes Menu Launcher ! 
 

Figure 13: Installation 
Finished 
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Uninstall Notes Menu Launcher 
All good things come to an end, and you might end up saying "No, Notes 
Menu Launcher was not for me". 

As a good citizen of the Windows community, Notes Menu Launcher 
therefore offers an uninstaller. An uninstaller is a little program that 
removes Notes Menu Launcher gracefully from the machine. Remember, 
the installer copies several files to different directories, and do numerous 
changes to the registry database, and even if it is fully possible to remove 
Notes Menu Launcher manually, it's not recommended. The uninstaller 
does this job for you! 

You can start the uninstaller in one of two ways.  

Via the Control Panel's Add or Remove Programs applet.  

 

After the Add or Remove Programs applet has started, locate  Notes 
Menu Launcher and press the Remove button. 

Figure 14: The Control 
Panel 
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After this operation, Notes Menu Launcher will be gone. Be sure to 
restart Lotus Notes to make the menu disappear. 

The other way to initialize the uninstaller, is to select the Uninstall Notes 
Menu Launcher from the Programs->Notes Menu Launcher menu: 

 
 

Figure 15: Add or 
Remove Programs 

Figure 16: Uninstall 
Notes Menu Launcher 
from the menus 
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Manual Installation 
This topic guide you through a manual install of Notes Menu Launcher. 
This is handy if you have multiple Notes clients installed on the same 
machine, or if you want to automate the installation of Notes Menu 
Launcher. 
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Notes Addin Menu Tools 
Notes Menu Launcher is a so-called Notes Addin Menu tool. This type of 
application has some general characteristics: 

 The application is visible in Lotus Notes's Actions menu. An example 
is shown below 

 
 It can be activated when certain conditions are met, such as; "Only be 

enabled when document is in edit mode, and that you have placed the 
cursor in a richtext field", or "Only be enabled when user is in a 
view". If the conditions aren't met, the menu item is disabled - or 
grayed out. 

 The application itself must be a DLL with specific functions. Please 
see the Notes C API documentation for specific details. 

 The DLL must be specified in NOTES.INI. Add the DLL filename to 
the AddInMenus keyword. If you don't place the DLL directly in the 
Notes Program Directory, you should specify the full path and 
filename. 
 
Note: The Notes.ini must be available in the first 128 bytes of the 
system environment variable PATH. 

The menu addin applications has several limitations, where the lack of 
document identification mechanism is one of the most severe. To 
overcome such limitations, Notes menu addin applications uses various 
techniques. 

 
 

Figure 17: Notes Action 
menu, with several menu 
addins 
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The Notes Menu Launcher Program Directory 
Notes Menu Launcher installs files in several directories, but the so-
called Application Directory is regarded as home. Typically this directory 
is placed somewhere along the Program Files directory structure. If you 
installed Windows with default directory structure, you'll find a 
C:\Program Files directory. Typically applications create a company 
subdirectory here, such as Microsoft, Adobe or Macromedia.The installer 
will try with a default company name of Voith's CODE for Notes Menu 
Launcher. In the company subdirectory C:\Program Files\<Name of any 
company> applications typically create an application directory. In our 
case the full application directory will be C:\Program Files\Voith's 
CODE\Notes Menu Launcher.  
 

The following files are placed here: 

Filename Description Filesize 
VCNMLM10.DLL The Notes Addin Menu module ~360 kB 

VCNMLCT10.DLL The Context Menu enabler ~300 kB 

VCNMLD10.EXE The Dispatcher ~460 kB 

UPDATE.EXE Notes Menu Launcher contains a feature to 
download updates via Internet, and this program file 
does that job. 

700 kB 

UPDATE.ICO Icon file for the Updater 29 kB 

UPDATE.CLI Data file for the Updater 23 KB 

DBGHELP.DLL DLL to aid enumeration of windows, classes and 
modules. 

~750 kB 

VCNPB100.EXE The NotesPeek Buddy module ~700 kB 

Notes Menu Launcher 
User's Guide.chm 

The HTML Help version of the User's Guide ~1.1 MB 

Samples folder A folder containing several XML configuration 
samples 

 

 

In addition you will also find an Uninstall directory containing the files 
necessary to uninstall (see "Uninstall Notes Menu Launcher" on page 23) 
the application. 
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The Notes Program Directory 
This is the directory where the main Notes files are placed. Search for 
NLNOTES.EXE and you are on the spot! You can also look in the Registry 
for the value of following key: 
HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes\Path.  

Please note that each version of Lotus Notes has it's own subkey in the 
Registry. The subkey above points to the most recent installation! 

If you install Notes R5 in the default directories, the Notes Program 
Directory will be C:\Lotus\Notes. If you do the same with Notes 6, the 
default program directory will be C:\Program Files\Lotus\Notes. 
 
The following files are placed here: 

Filename Description Filesize 
NDBVCNML.DLL A Notes Database Driver used to among other things 

identify current context. This is called directly by 
Lotus Notes and Notes won't look in other 
directories! 

57 kB 

 

Very important: In order to have Notes C/C++ API based applications run 
correctly, these applications must know where to find the core Notes 
program files. The C and C++ API libraries use functions in all the 
DLLs! This is done by specifying the Notes Program Directory in the 
PATH environment variable. In Windows 95, 98 and ME, this is set in 
the AUTOEXEC.BAT file with the command  
 
SET PATH=%PATH%;<full path to the Notes Program 
Directory> 
 
In Windows NT, 2000 and XP the PATH environment variable is set 
from the System applet in the Control Panel. Be sure to have 
Administrators Rights in order to change this variable's content. 
 

The Notes Data Directory 
The Notes Data Directory the directory where Lotus Notes place it's 
database files (all the NSF and NTF files among others).  

In its current version, Notes Menu Launcher does not install any files in 
this directory. 
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The Windows System Directory 
The so-called System directory is where applications may place "system 
components" . In the previous years, this directory was heavily used by 
many applications, and you typically find thousands of files in this 
directory. However, in more recent years, Microsoft has recommended 
application developers not to use this directory, unless the component is 
meant for sharing between several applications. Typically the exact path 
to the system directory is C:\Window\System32 or C:\WINNT\System32 if 
you have installed Windows in it's standard directories. If you are 
uncertain what your system directory is, take a look at the PATH 
statement definition. The System directory is very often specified there, 
since this directory contains many many common and shared component 
files. 
 

In its current version, Notes Menu Launcher does not install any files in 
this directory. 

 
 

The Temporary Directory 
Notes Menu Launcher creates several files during operation, and it will 
remove the files after normal operation. In the unfortunate situation of a 
application crash, or other malfunction, the temporary files won't be 
automatically removed. No important information is ever stored here, so 
you can safely remove all temporary files! 

Tip: Look for files with the prefix VC. 
 



 

30 Notes Menu Launcher User's Guide 
 

Necessary Changes to the Registry 
Notes Menu Launcher makes several modifications to the registry.  

Note: Some of the settings are obfuscated, to keep your registration 
information a little bit more secure for prying eyes. This information is at 
the present time not possible to recreate in a manual matter. 
 
Another thing to note; If you select to install Notes Menu Launcher for all 
users, the following keys and values below should be placed in the 
HKEY_LOCAL_MACHINE\Software hierarchy. If you just want to install for 
the current user, place keys and values in the 
HKEY_CURRENT_USER\Software hierarchy. Read much more about that 
here. 

Below you see an image of the registry content: 

 

The Options and Data keys are obfuscated. Below is a table which 
identifies each key and it's value 

Key Value 
Install\Data Obfuscated 

Install\NotesINIFiles Used by the installer to keep track of which 
NOTES.INI files it has modified with the necessary 
NOTES.INI changes.  Note that this subkey contains 
a separate line for each Notes version 

Install\NotesProgramPaths Also used to keep control overwhich versions that 
have been modified.  Note that this subkey contains 
a separate line for each Notes version 

Figure 18: The 
HKEY_LOCAL_MACHI
NE hive 
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Install\NotesVersions Which Notes versions has been modified ? The 
numbers seen here relate directly to the Notes 
versions that have been modified. You should find a 
value with this number in both Install\NotesINIFiles 
and Install\NotesProgramPaths 

Install\Options Obfuscated 

Install\Path The full path to where the main application file 
specified in the key Settings\Doer\Module, see 
below 

Install\PCode Product Code. This is used if you want to upgrade 
the software via Internet. The PCode has the 
following meaning: 
VCNML_R<Release number>_L<Language 
number>. Currently we are on release 1, and the only 
available language is 9 meaning English. 
VCNML=Voith's CODE Notes Menu Launcher by 
the way! 

Settings\Doer\Module The full path and file name of the Dispatcher 
application file, the so-called "doer". The default 
value is VCNMLD10.EXE.  

Settings\Doer\ContextMenu
Module 

The fill path and file name of the Context Menu 
module. The default value is VCNMLCT10.DLL 

Settings\Doer\Title The title of the application 

Settings\Doer\Menu\ 
Messages 

Several messages used by the Notes Menu Addin 
DLL to inform user about potential problems. 

Settings\Doer\Menu\Title The menu item title as it will be shown in the 
Actions menu in Lotus Notes. If you use an 
ampersand (&) this will be the keyboard accelerator 
in the menu. 

Settings\Version The current build-version of Notes Menu Launcher. 
Note that you might stay on release 1.0 for a long 
time, but the build numbers increase as bug fixes etc. 
are implemented. 

 

Also note that NotesPeek Buddy has got its own subkey at 
HKEY_LOCAL_MACHINE\Software\Voith's CODE\NotesPeek Buddy. The 
only value present is Install, which holds the full path and filename to the 
NotesPeek Buddy module. The default value is VCNPB100.EXE. 
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Necessary Changes to Notes.ini 
In order to run Notes Menu Launcher, it must be registered as a Notes 
Addin Menu (see "Notes Addin Menu Tools" on page 26) tool. This is 
primarily done with the AddInMenus keyword in the configuration file 
NOTES.INI.  

Note: Different versions of Lotus Notes have over the time placed 
NOTES.INI in several directories. The best tip is to use the Windows 
Search for files tool and locate your NOTES.INI. This will at the same 
time reveal if you have multiple NOTES.INIs on your machine.If so, it's 
very important to modify the correct one. If you for example have Notes 
R5 and Notes 6 installed simultaneously, you must know which version 
you installed latest, since all Registry modifications done by the Notes 
installer always point to the latest installation.  
 
If you want to use an earlier Notes version, you must also ensure that the 
PATH environment variable also point to the old installation, and not the 
current installation. 
 
The trick is to get Notes Menu Launcher to use the Notes DLL files of the 
version you plan to use Notes Menu Launcher in. Notes Menu Launcher 
probably can't operate in two different Notes versions simultaneously, . 

Below you see a snippet from a NOTES.INI file with only Notes Menu 
Launcher's Addin menu DLL, and no other previous Notes Menu Addin 
tools registered: 

[Notes] 
... 
AddinMenus=VCNMLM10.DLL 
... 

This could also have been specified like this: 

[Notes] 
... 
AddinMenus=C:\Progra~1\Lotus\Notes\VCNMLM10.DLL 
... 

And finally you see how the AddInMenus look like when it has more 
than one Addin Menu. The comma is used as separator between the 
DLL's 

[Notes] 
... 
AddinMenus=VCNMLM10.DLL,TANSA2.DLL,NSFINFO.DLL 
... 

The sequence of the DLLs determine the order of the menu items in the 
Actions menu. 
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Security 
Lotus Notes has always been a very secure place to store data. Nothing - 
repeat - nothing, can access Notes data without having a valid user ID 
file. We say we operate in the context of a specific user ID. This implies 
that Notes Menu Launcher will have the same rights as the currently used 
ID file, and you cannot access data you're not authorized to access. 

Lotus Notes normally asks for a password during startup (this feature can 
be turned off, if you have enabled automatic synchronization between 
your Windows user id and Notes. Refer to the installation of Lotus Notes 
for further details). When entered and accepted, Lotus Notes let you 
access all the data that you have access to. 

When you run additional so-called Notes based applications - such as 
Notes Menu Launcher, you will also normally be prompted for a 
password. It may look something similar to this dialog box: 

 

This will happen every time you start the Notes based application.  

Why is it like this ? It has all to do with security of your data. Nothing 
that you don't explicitly allow to access your data, should be able to do so 
behind the scenes. Imagine how trojan- and virus like applications could 
install silently and access your data without you knowing it - that would 
be considered a severe security breach!  

How to make Lotus Notes stop asking for a password all the time ? 

Unfortunately the standard Notes security makes your legal Notes based 
applications cry for password every time they access Notes data. Lotus 
has a feature which allows you to trust all Notes based applications at 
large. 

This feature is controlled within the dialog box of your Notes user ID file, 
and is thus protected by the heavy Notes user ID protection logic of Lotus 
Notes. The procedure to allow Notes based applications access, differs a 
little bit between Lotus Notes Release 5 and Notes 6. 

How to allow Notes based applications access to Notes data in Lotus 
Notes Release 5 

Figure 19: Lotus Notes 
API Asks for Password 
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Access your user ID dialog box via the menu File -> Tools -> User ID. You 
may have to enter your Notes password. In this dialog box you will see 
the following field on the Basics tab. 

 

When you select Don't prompt for a password from other Notes-based 
programs, you will not be asked for a password. 

How to allow Notes based applications access to Notes data in Lotus 
Notes Release 6 

Access your user ID dialog box via the menu File -> Security -> User 
Security. You may have to enter your Notes password. In this dialog box 
you will see the following field on the Security Basics tab. 

 

Figure 20: User Security 
in Notes 5 
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When you select Don't prompt for a password from other Notes-based 
programs (reduces security), you will not be asked for a password. 

Things to think about when you do this 
 
Selecting to trust Notes based applications like shown above will trust all 
Notes based applications at large. Either you trust none, or you trust all! 
You cannot select which applications to trust and which you don't trust.  
 
This has some security aspects, since it expose your system for 
potentially malicious code. After you select this feature, Notes based 
applications can access your Notes data without you knowing it.  
 
So what to do ? A software vendor (like Voith's CODE...) tells you to 
install a tool (such as Notes Menu Launcher...) and that you must enable 
the don't prompt for password-feature above in order to avoid password 
popups. Make an assessment of the vendor. Is the vendor trustworthy ? 
Then make an assessment of the application. Should the application be 
trusted ? If answers to both questions are yes, then enable don't prompt 
for password, otherwise don't.  
 
But what's more important: You must pay attention to any following 
Notes based applications you may install later. These applications now 
have direct access, since the don't prompt for password-feature already 
has been turned on. 

 

Figure 21: User Security 
in Notes 6 
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Notes Menu Launcher will typically not make too much noise of itself. It 
is after all just an enabler to put your own applications, formulas or 
agents in the menus of Lotus Notes. 

This chapter will guide you through normal operation of Lotus Notes 
with Notes Menu Launcher installed 

In This Chapter 
Has Notes Menu Launcher been updated ?........................40 
The Action menu................................................................41 
The Context Menus ............................................................42 
NotesPeek Buddy...............................................................43 
NotesPeek itself..................................................................44 
 
 

C H A P T E R  3  

Operation 
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Has Notes Menu Launcher been 
updated ? 

Notes Menu Launcher is equipped with an updater tool. An Updater is a 
small application that will check- and potentially retrieve, any new 
versions of Notes Menu Launcher for you. You launch the Updater by 
clicking the Check for Update menu: 

 

 

When you select this menu you will see the Updater application dialog 
box: 

 

Press Next to continue or Configure to set information such as network 
Proxy etc. If you press Next, the Updater will check with the central 
Voith's CODE-server to see if any updates has been posted. If so, you 
will be guided through the update process 
 

Figure 22: The Check for 
updates menu 

Figure 23: The Updater - 
Welcome 
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The Action menu 
Notes Menu Launcher can install menus in the Action menu in Lotus 
Notes. These menus is visible when you select the Action menu. They are 
always positioned at the bottom of the menu. You will not see cascaded 
menus here. Below is a sample of an Action menu; 

 

All the menus in the red box are Notes Addin menus.  

 
 

Figure 24: Notes Action 
menu, with several menu 
addins 
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Addin Menus are Context Sensitive 
When you work in Notes, you work with workspace, databases, views, 
documents and fields. Sometimes the documents are in read mode, and 
sometimes they are in write-mode. 

A Notes Addin Menu knows exactly where you work, and what edit-
mode you are in. In addition addin menus knows what field you are in 
when you are editing a document. 

If you are working in a view, a addin menu also knows something about 
your current document selection. Have you selected multiple documents, 
or are you just working on one document ? 

Note: Notes Addin Menus have always had some problems identifying 
multiple document selections if you are working in a view through a 
frameset. In short; frameset-solutions may have problems with Notes 
Addin Menus! 

 
 

The Context Menus 
Context Menus in Lotus Notes are, just as Notes Addin Menus, context 
sensitive. If you right click on a view entry, you will see the view context 
menu, and if you right click on a document in write-mode you will get 
another context menu. 

Notes Menu Launcher has some limitations regarding context menus 

 In its current state, Notes Menu Launcher only support two context 
menus, the view- and the document context menus. Notes Menu 
Launcher can't determine if the document is in read- or write mode 
when it displays the menus. As soon as the menu is selected, Notes 
Menu Launcher is able to tell the difference, so your own 
applications, formulas or agents can act accordingly. 

 Notes Menu Launcher can't identify multiple document selections. In 
other words, Notes Menu Launcher can only work on the currently 
selected document 
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NotesPeek Buddy 
To demonstrate Notes Menu Launcher, it comes with a built-in support 
for NotesPeek Buddy. This is a small NotesPeek-enabler, which will 
launch NotesPeek for you and automatically navigate to the currently 
selected document. In other words, a much quicker way to launch 
NotesPeek directly on the selected document! 

Note: Notes Menu Launcher does not include NotesPeek software itself. 
NotesPeek can be downloaded from this article http://www-
10.lotus.com/ldd/today.nsf/0db661345413ad1d852567ba006bb090/23d24
ec8a4c568e9852566320058521d?OpenDocument at IBM, an in addition 
you can find the new ND6 version of NotesPeek at The NotesPeek ND 6 
homepage http://www-
1.ibm.com/support/docview.wss?rs=474&uid=swg24005686. 

When you launch NotesPeek via Notes Menu Launcher for the first time, 
you will see the following dialog box; 

 

From this dialog box you select where you have installed NotesPeek on 
your machine. Notes Menu Launcher will store your path to NotesPeek in 
the Registry. If you move or change the path of NotesPeek, Notes Menu 
Launcher will ask you again. 

The path to NotesPeek is stored in the following registry subkey: 

HKEY_CURRENT_USER\Software\Voith's CODE\NotesPeek Buddy and 
value NotesPeekPath. 

Figure 25: NotesPeek 
Buddy 
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NotesPeek itself 
For years, NotesPeek has been the de facto standard application to dive 
into the inner details of Notes databases. The name with the suffix "peek" 
reminiscence the old days when programmers frequently had to read 
content at memory locations by "peeking", and writing to memory 
locations with "poking". In addition the icon x-raying the "Notes-folks" 
identify the purpose of NotesPeek quite good: 

 NotesPeek was written by Ned Batchelder, a former Lotus 
employee. The user interface is clean and intuitive using the treelist to 
navigate in databases, documents and fields. The content is shown in the 
main area to the right. Below you see a screenshot of NotesPeek. 

 

You will find all sort of information here, and as you see from the 
screenshot above, you can really dive into richtext to see how the CD 
records are sequenced and what they contain.  
 

Figure 26: NotesPeek 
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In This Chapter 
Overview............................................................................45 
The XML File ....................................................................47 
 
 

Overview 
Notes Menu Launcher is configured with a XML file. The following 
steps are performed at startup of Lotus Notes 

1 When Lotus Notes starts, Notes Menu Launcher is activated since it 
contains a Notes Addin Menu DLL. 

2 Looks in the Registry to see where the XML file is located.  

3 Read and process the XML file 

4 Insert any potential Action menus 

5 Prepare context menus for display.  
 
The next steps are performed when the user selects one of "our" 
menus: 

6 Accept menu selections in Lotus Notes 

7 Replace any runtime variables  

8 Relay menu ID to dispatcher module in Notes Menu Launcher 

9 Execute specified actions in the XML file for the selected menu 

Since all Notes Menu Launcher-operation is controlled by the XML file, 
most of this chapter will look into XML details. 
 

C H A P T E R  4  

Configuration 
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The XML File 
The configuration of Notes Menu Launcher is based upon a XML file. 
Notes Menu Launcher can load the XML file from several sources. This 
is all controlled by a flag in the Registry. The Registry subkey is; 

HKEY_LOCAL_MACHINE\Software\Voith's CODE\Notes Menu 
Launcher\Install with the value Config and it's string value (REG_SZ).  

If the Config-value doesn't exist (which is the case for a freshly installed 
version of Notes Menu Launcher), a default XML configuration file will 
be loaded, enabling NotesPeek Buddy (on page 43) to launch on the 
currently selected document. 

If the Config-value contains a string of the value "1", the XML 
configuration file will be loaded from the filesystem. The appurtenant 
value ConfigFilename specify the full path and filename of the XML file. 

Below you see the general structure of the XML file. The subsequent 
topics will dive into the details: 

<NotesMenus> 
 <NotesMenu> 
  <Actions> 
   <Action>...</Action> 
   <Action>...</Action> 
   ... 
  </Actions> 
  ... 
 </NotesMenu> 
 
 <NotesMenu> 
  <Actions> 
   <Action>...</Action> 
   <Action>...</Action> 
   ... 
  </Actions> 
  ... 
 </NotesMenu> 
</NotesMenus> 

The main elements in the XML file are: 

 NotesMenus - This top element defines the whereabouts for Notes 
Menu Launcher in the Registry. In addition it holds one or more 
NotesMenu (note, singular!) elements. 

 NotesMenu - The is the element registering one menu item! It 
contains another collection element, the Actions-element 

 Actions - W wrapper element for one or more Action-items. 
 Action - The Action element is the beef of the specification, telling 

Notes Menu Launcher what to do 
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How Notes Menu Launcher communicates to the outside 
One of the key features of Notes Menu Launcher is the ability to launch 
other applications, agents or formulas. How can those other applications 
know what database and documents the user just have selected ? 

 
 

Via the Registry 

All information is placed in a volatile key in the Registry, at the so-called 
LastRun subkey of Notes Menu Launcher. Every time the user select one 
or more  documents in a view or document, and then invoke one of "our" 
menus, the LastRun-subkey will be updated. 

In addition, when the menu execute either a NotesAgent (on page 59) or 
NotesFormula, (see "NotesFormula" on page 59) several entries will be 
written to the Notes.ini. 

The exact placement of the LastRun-subkey is determined by parameter 2 
in the XML configuration file. This will be discussed in detailed later in 
this chapter. For example the complete subkey can be; 

HKEY_CURRENT_USER\Software\Voith's CODE\Notes 
Menu Launcher\LastRun 

Note that the hive is the CURRENT USER! 

The values stored in the LastRun-subkey are as follows (note, all values 
are of type string REG_SZ); 

Value Description 
Config The full path and filename of the XML configuration file. 

Note that this value can also be the path and filename to 
the default, built-in XML configuration file. 

SID The ID of the current menu selection. This is the ID value 
directly in the NotesMenu-element (see "NotesMenu 
element - one for each menu" on page 52). Please ensure 
that you use only unique IDs when you configure Notes 
Menu Launcher! 

Server The Domino server name of the selected database. It can 
also be blank or not specified at all, and then the database 
in question is located on the local client. 

Database The relative Notes database filename of the selected 
database. You can also use a replica ID here if you prefer. 
If you do, be sure to specify the replica id on the format 
similar to the sample below; 

C1256981:0043BC90 
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Context A value indicating the user operating context. The values 
are: 

103 = In a document, in read mode 

104 = In a document, in edit mode 

200 = At the workplace 

201 or 0 = In a Notes view 

NoteID One or more comma separated NoteIDs. Note that all 
NoteIDs are in the decimal form. 

By querying these values in your own applications you can work out 
what document(s) to work on. 

 
 

Via Notes.ini 

If you have an action type of NotesAgent (see "SendKeys" on page 57) or 
NotesFormula, (see "NotesFormula" on page 59) certain variables are 
updated in Notes.ini 

The list of variables is a bit special due to the length-constraint of values 
in Notes.ini. The maximum length of any value is 256 character. 
Therefore Notes Menu Launcher has to keep track of the value-length! 

Also remember that the values are valid for the current selection only. 

The keywords and their values are; 

Keyword Value 
$NMLVAR_NumberOfLists How many variable name lists do we 

have ?  

$NMLVAR_List_0 ... 
$NMLVAR_List_n 

You find a variable name list starting 
on 0 and incrementing up to the 
number in 
$NMLVAR_NumberOfLists. 

The values are semi-colon separated, 
and look like this; 

NOTES_SERVER;NOTES_DATABA
SE_RELATIVEPATH;NOTES_DAT
ABASE_FILENAME 

For each value you will find an 
individual keyword prefixed with 
"$NMLVAR_". For example, you will 
find a $NMLVAR_NOTES_SERVER. 

If the value isn't present in Notes.ini, 
the value is empty, and for the 
example with the Notes server above, 
it means that the selected database is 
on the local client. 
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$NML_Variable_Count How many variable names has been 
written to the variable name lists 
above. 

You can easily use these values in your @Formulas or LotusScript 
agents. 

 
 

Via parameters 

When a menu is selected, certain variables are available at run time. It 
makes it easy to transfer information to your application as parameters. 
The list of variables are: 

Variable Description 
(NOTES_SERVER) The Domino server of the selected 

database 

(NOTES_DATABASE_REL
ATIVEPATH) 

The relative path and file name of the 
selected database 

(NOTES_DATABASE_FILE
NAME) 

The filename only of the selected 
database 

(NOTES_USERNAME) The annotated user name on the form 
CN=UserName/O=Organisation 

(NOTES_NOTEID) A semi-colon separated list of the 
selected NoteIDs. The format is 
decimal number. 

(NOTES_HEXNOTEID) A semi-colon separated list of the 
selected NoteIDs. The format is a hex 
number. 

(NOTES_DATABASE_REP
LICAID) 

The replica id of the selected database. 
The format is like:  

C1256981:0043BC90 

(NOTES_DATABASE_ID) The database id of the selected 
database. Note, this id is often the 
same as the replica id, and change 
only if the database is repaired or 
compacted. The format of the database 
id is: 

C1256981:0043BC90 

(NOTES_DATABASE_TIT
LE) 

The title of the selected database 

(NOTES_CATEGORIES) The categories of the selected database 

(NOTES_TEMPLATE_NA
ME) 

The template name in the selected 
database. 

(NOTES_TEMPLATE_FILE
NAME) 

The template filename of the selected 
database 
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NotesMenus - the to element 
The top element in the XML configuration file is the NotesMenus 
element. Below you see a complete specification: 

<?xml version="1.0" encoding="ISO-8859-1"?> 
<NotesMenus 
 Name="Notes Menu Launcher"  
 PollingInterval="250"  
 Param1="Reg. path to Dispatcher"  
 Param2="Reg. path to LastRun"  
 Param3="Reg. to error messages" 
 Param4="Reg. path to Install"> 
 
 <NotesMenu ID="0LNPK"> .... </NotesMenu> 
 
</NotesMenus> 

The attributes of the NotesMenus-element are; 

Attribute Description 
Name The name of the menu implementation. The name 

has no practical use in Notes Menu Launcher 

PollingInterval When Notes Menu Launcher perform actions 
involving resource enumeration, such as 
enumerating all the windows or classes running on 
a system, it uses this interval to look for changes. 

Param1 Registry path to the HKEY_LOCAL_MACHINE 
hive, specifying where the Dispatcher application 
is located. When Notes Menu Launcher is about to 
launch the Dispatcher, it uses this key to locate 
what application to look for.  

The default value is: 

Software\Voith's CODE\Notes Menu 
Launcher\Settings\Doer 

Param2 Registry path to the HKEY_LOCAL_MACHINE 
hive, specifying where Notes Menu Launcher store 
all information about the last run, identifying 
server, database and note ids. 

The default value is: 

Software\Voith's CODE\Notes Menu 
Launcher\LastRun 

Param3 Registry path to the HKEY_LOCAL_MACHINE 
hive, specifying where the error messages are 
specified in case of errors. 

The default value is: 

Software\Voith's CODE\Notes Menu 
Launcher\Settings\Menu\Messages 
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Param4 Registry path to the HKEY_LOCAL_MACHINE 
hive, specifying where the Notes Menu Launcher 
store its initial settings 

The default value is: 

Software\Voith's CODE\Notes Menu 
Launcher\Install 

Note that you can only have one NotesMenus element.  
 

NotesMenu element - one for each menu 
For each menu you want to specify either in the Actions menu or in the 
context menus, it must have a NotesMenu element. Note that one 
NotesMenu element can be placed in both Actions- and context menu. 

A sample of a NotesMenu element with attributes and sub-elements are; 

 

<NotesMenu ID="0LNPK"> 
 Notes Menu LauncherNotesPeek ...</Name> 
 <MenuFlags>NCM_IN_VIEW, NCM_IN_DOC</MenuFlags> 
 <InitialAction>Start</InitialAction> 
 <Timeout>5000</Timeout> 
 
  <Actions>....</Actions> 
 
</NotesMenu> 

 

Attribute Description 
ID The ID is an unique key for each menu. You must 

ensure yourself that the IDs really are unique. The 
unique key will be used later to connect the selected 
menu with the real action to perform. 

Also note that the ID will sort the sequence of the 
menus! If you have a NotesMenu-element with ID 
= "1ABC", and the next NotesMenu-element has ID 
= "0XYZ", the second NotesMenu-element will 
show first, due to element sorting in Notes Menu 
Launcher. 
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The sub elements of NotesMenu-element are 

Element Description 
Name The name you want to display in the menu. Note 

that this name can be hierarchical, were each part is 
separated by a backslash. For example: 
 
Development\Formula Tester ... 

If you use that name in a context menu, it will 
become a cascaded menu like the sample below; 

Figure 27: Notes Context Menu - Example 1 

 

If you use the same name in an Action-menu, Notes 
Menu Launcher will only use the last part 
(Formula Tester ... in our sample) 

MenuFlags Where should this menu show and when ? See 
below for valid MenuFlags (see "Where to use a 
menu - the MenuFlags" on page 54)-codes. Note 
that several codes can be combined in order to make 
the menu show up both in Action- and context 
menus. 

InitialAction A NotesMenu-element contains one or more 
Action-sub elements, specifying exactly what to do 
when this menu is selected. The InitialAction-
element contain the name of the initial Action. 

Timeout  The timeout for all NotesMenu actions combined to 
complete successfully. If the NotesMenu as a whole 
take longer time, it will time out. 
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Where to use a menu - the MenuFlags 

The MenuFlags sub element of the NotesMenu-element determine where 
a menu should show and when to show it. Notes Menu Launcher is to a 
certain degree sensible to the user operation context, and allows the 
menus to show only if certain conditions are met. 

For example, it's easy to tell Notes Menu Launcher not to show the 
menus in anything else but an open document in edit-mode. If the 
document is in read-mode, or the user is operating in a Notes view, the 
menu won't be activiated. 

Note: The prefixes you see in all the menu flags has this meaning: 
NAM - Notes Addin Menu 
NCM - Notes Context Menu 

The MenuFlags for Notes Addin Menus are: 

MenuFlag Description 
NAM_IN_DESK Activate the menu when the user is at the 

Workplace or homepage.  The user hasn't 
moved into a specific database right yet. 

If you have a traditional workplace which 
show for example your Inbox and Calendar, 
Notes Menu Launcher is still able to 
determine the active document beneath the 
cursor.  

Document selections are not supported a 
this level 

NAM_IN_VIEW Activate the menu when the user is in a 
NotesView 

NAM_IN_DOC_READONLY Activate the menu when the user is in a 
document, and the document is in read-
mode 

NAM_IN_DOC_READWRITE Activate the menu when the user is in a 
document, and the document is in edit-mode 

NAM_IN_FIELD_TEXT Activate the menu when the user is in an 
edit-mode document, and the cursor is 
placed in a text-field. Note, you must also 
specify NAM_IN_DOC_READWRITE in 
order to get this flag to work 

NAM_IN_FIELD_NUMBER Same as for NAM_IN_FIELD_TEXT, but 
for field type Number 

NAM_IN_FIELD_TIMEDATE Same as for NAM_IN_FIELD_TEXT, but 
for field type Time/date 

NAM_IN_FIELD_RICHTEXT Same as for NAM_IN_FIELD_TEXT, but 
for field type Richtext 

NAM_IN_FIELD_READERS Same as for NAM_IN_FIELD_TEXT, but 
for field type Readers 
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NAM_IN_FIELD_AUTHORS Same as for NAM_IN_FIELD_TEXT, but 
for field type Authors 

NAM_IN_FIELD_NAMES Same as for NAM_IN_FIELD_TEXT, but 
for field type Names 

NAM_IN_FIELD_KEYWORDS Same as for NAM_IN_FIELD_TEXT, but 
for field type Dialog List 

NAM_IN_FIELD_SECTION Same as for NAM_IN_FIELD_TEXT, but 
for sections 

 

The MenuFlags for Notes Context Menus are; 

MenuFlag Description 
NCM_IN_VIEW Show the context menu if the user is in a view 

NCM_IN_DOC Show the context menu if the user is in a document. 
It can't - at the display moment - tell the difference 
between read- and edit mode. 

 

As you see, you have considerable better control over Notes Addin 
Menus than Notes Context Menus! 
 

The Actions element 
The Actions element is just a wrapper element, containing one or more 
Action-elements. 
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The Action element 
Notes Menu Launcher can perform a series of actions when a menu is 
selected. Each Action element describe an action to perform, and if the 
action is successful, the next step execute. By having this chain-of-
actions style, you can perform any number of actions for a menu. 

Often an Action contain a command and several parameters. The 
command (or Action types as they are called later) and their parameters 
are specified later in this chapter. 

Below you see a sample Action 

<Action ID="Start"> 
 <Type>LaunchApplication</Type> 
 <Parameter1>NOTEPAD.EXE</Parameter1> 
 <Parameter2>C:\TEST.TXT</Parameter2> 
 <Parameter3>Extra params</Parameter3> 
 <ActionSucces>Finish</ActionSucces> 
 <ActionFailure>NotFound</ActionFailure> 
 <Timeout>5000</Timeout> 
</Action> 

First, each Action within an Actions-wrapper element, must have an 
unique ID. It's again up to you to ensure that really is the case. Since each 
action contain a pointer to the next action, the sequence of actions within 
the Actions-element is not important. 

This sample has set the type to LaunchApplication. This is one of the 
actions types (or commands) Notes Menu Launcher understands and 
performs. You also see that this type requires at least one parameter, 
specified as Parameter1. In this sample we try to launch Notepad.exe with 
the parameter C:\Test.txt. If that succeeds, Notes Menu Launcher 
advances to the next Action-element; Finish, and if it fails, the Action 
element NotFound is executed. 

Next you see all the different action types: 
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LaunchApplication 

This action type will try to launch the specified application as Parameter1. 
Any potential parameters to the application to launch, must be specified 
as Parameter2. 

The Parameter3 can contain special commands for LaunchApplication. 
They are: 

Command Description 
KillExistingModuleFirst If this command is specified, Notes 

Menu Launcher will only allow one 
instance of the application specified in 
Parameter1 to exist. This can be nice if 
you don't want to launch multiple 
instances of an application. 

 
 

SendKeys 

The SendKeys action type is very useful, as it can send keystrokes to 
another application. It will send any characters located in Parameter1. 

First of all, SendKeys can send any normal keystroke to an application. If 
you want to type text, you can easily do that by just typing characters into 
Parameter1. In addition it can also send special keystrokes, such as F-
keys, ALT, SHIFT and CTRL modified keys.  

The table below specify the key codes that can be repeated. When you for 
example see that the key code is {LEFT}, this will move the cursor left 
once. You can specify how many time each key should be inserted by 
suffixing a number, like this; {LEFT 9}, which move thcursor left 9 
times. 

Code Description 
{BACKSPACE}, {BKSP} or 
{BS} 

Backspace 

{BREAK} Break or cancel 

{CAPS} Toggle Caps Lock 

{DELETE} Delete  

{INSERT} Insert 

{DOWN} The down arrow button 

{UP} The up arrow button 

{HOME} Home 

{END} End 

{ENTER} Enter 

{LEFT} Left arrow button 
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{RIGHT} Right arrow button 

{PGUP} Page up 

{PGDN} Page down 

{NUMLOCK} Toggle numlock key 

{HELP} Help 

{PRTSCR} Print Screen button 

{SCROLL} Toggle Scroll Lock button 

{TAB} Tabulator key 

{F1} to {Fnn} Any Function key 

 

Special key codes 

Code Description 
{PAUSE n} Pause for n seconds. This very useful 

if you need to give the application you 
command, some time to perform some 
action, before issuing another 
keystroke. 

 

Special shorthand characters that can be used to indicate a key 
combination: 

Character Description 
~ Enter, same as {ENTER}.  

+ Shift. For example +a will insert an 
uppercase A. 

^ Control, for example ^A will insert the 
key combination CTRL+A. 

% Alt, for example the %f will insert the 
key combination ALT+F. 

[ Group start, see Group End 

] Group end. You can group characters 
together by enclosing them in square 
brackets. 
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NotesAgent 

The action type NotesAgent will run an agent in an Notes database. The 
agent must be of type Run Once.  

In order to run an agent, Notes Menu Launcher need to know where the 
agent is located. Parameter1 contains the Domino server, or blank if the 
database containing the agent is on a local client. Parameter2 contains the 
relative database file name and Parameter3 contains the agent name. 

Note that this agent type also update variables (see "Via Notes.ini" on 
page 49) in Notes.ini in order to communicate better with the agent. 

 
 

NotesFormula 

The NotesFormula action type execute the @Formula located in 
Parameter1.  

Note that this agent type also update variables (see "Via Notes.ini" on 
page 49) in Notes.ini in order to communicate better with the formula. 
 

WaitForWindowTitle 

The action type WaitForWindowTitle will instruct the action to wait for a 
specified window title for a specified time. The window title to look for is 
specified as Parameter1. 

The action type can have special additional commands specified as 
Parameter2.  

Command Description 
ExtactMatch If this command is specified in Parameter2, the window title 

in Paramater1 must be exactly equal.  

For example, your Notepad windows title look like this: 

Notepad - c:\test.txt 

If you specify the exact same string in Parameter1 and in 
addition ExactMatch in Parameter2, the action will succeed 
if the Notepad session actually exist or start within the 
timeout value. 

If you just want to look for "Notepad", then don't specify 
ExtactMatch. Notes Menu Launcher will then accept any 
windows title containing the word "Notepad". 

BringToTop If the window title in Parameter1 is found within timeout 
value, the process will be brought to the top, overlaying any 
potential other windows on your desktop. This is the same as 
manually setting the focus on a window 
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If the window exist or start within the timeout value, the action specified 
in ActionSuccess will be executed, otherwise the event specified in 
ActionFailure will be executed. 
 

WaitForClass 

The action type WaitForClass will wait for a class name, just like 
WaitForWindowTitle (on page 59). A class name is best viewed with 
Process Monitors, such as Spy++ http://msdn.microsoft.com/library/en-
us/vcug98/html/_asug_home_page.3a_.spy.2b2b.asp from Microsoft or 
Winspector http://www.windows-spy.com/ from Gipsysoft. 

Below you see a dialog box from Spy++ showing the class name for 
Lotus Notes: 

 
 

Figure 28: Showing the 
Class of an application 
with Spy++ 
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WaitForModule 

The action type WaitForModule will wait for a module name, just like 
WaitForWindowTitle (on page 59). A module name is best viewed with 
Windows Task Manager, most so-called Process Monitors, such as 
Spy++ from Microsoft. 

Below you see the dialog box from Windows Task Manager, showing the 
module name: 

 
 

WaitForWindowDialog 

The action type WaitForWindowDialog will wait for a dialog box title, just 
like WaitForWindowTitle (on page 59) 
 

Figure 29: Showing the 
module name in Windows 
Task Manager 
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The built-in NotesPeek Buddy 
If you don't specify any configuration XML file for Notes Menu 
Launcher, it will use it's own built-in NotesPeek Buddy (on page 43) 
XML file. Below you see what that file look like; 

 
 Figure 30: The 

NotesPeek Buddy XML 
File 
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